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INTRODUCTION 

WELCOME… 

… to Sanako Study 700, a software language learning 
solution that combines the use of multimedia with a suite of 
essential classroom management tools. Study 700 helps 
teachers deliver effective instruction in any subject area. 

Since it is a pure software solution, Study 700 does not 
require any additional hardware and is therefore easy to 
install and maintain. 

WHAT CAN YOU DO WITH STUDY 700 

Study 700 allows teachers to use their digital learning 
resources to help manage student activity in a stimulating 
interactive environment. The software makes it easy for 
teachers to launch applications and assignments for 
students, upload session files for guided learning activities, 
monitor student screens for support and collaboration, and 
even focus use of the Internet for managed web-based 
learning activities. Communication resources such as live 
two-way audio and text messaging also make it easy for 
teachers to provide individual support for students in need. 
They can also be used to create another layer of interactive 
language-based activities.  

The basic platform of the Study 700 system can be easily 
upgraded and enhanced with separate extension modules, 
making it a flexible solution that can be modified to suit your 
specific teaching needs. 

 





 Getting started    3 

GETTING STARTED 

STUDY 700 SYSTEM COMPONENTS 

STUDY 700 TUTOR 

Teachers use the Study 700 Tutor application, which is the 
main interface to the Study 700 system. The Tutor 
application allows teachers to instruct with the Study 700 
system and to control the classroom computers. 

STUDY 700 STUDENT 

The Study 700 Student application is installed onto all 
student computers. Study 700 Student connects to Study 
Server at system startup and runs in the background 
listening for commands from Study 700 Tutor.  

Students can open the student interface to work 
independently, however, teachers are able to control student 
computers, regardless of whether the Student application is 
visible on student screens. 

STUDY SERVER 

Study Server application is the information center of the 
Sanako Study 700 system and both the Tutor and Student 
components automatically connect to it. All system data is 
passed through the Server and it allows communication 
between the Tutor and Student components. 

EXTENSION MODULES FOR STUDY 700 

The functionality of the Study 700 system can be extended to 
suit more specific needs and tasks with additional modules. 
The available extension modules for Study 700 include:  

 Sanako Study Examination Module 
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 Sanako Study Video Live Module 

 Sanako Admin Tool 

 AP- Exam for Study 700 

 Listening Comprehension for Study 700  

 Model Imitation for Study 700  

 Reading Practice for Study 700  

 Round Table Discussion for Study 700  

 Vocabulary Test for Study 700  

 Text-to-Speech for Study 700  

 MP3 Encoding for Study 700  

You can find descriptions and more information on each 
extension module in the Extension modules for Sanako 
Study 700 section at the end of this User Guide. 
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STUDY 700 TEACHER 
APPLICATION 

OVERVIEW 

SESSIONS & ACTIVITIES 

Sessions and activities are two key concepts that form the 
basis of teaching with the Study 700 application 

SESSIONS 

In Study 700, students can be divided into six different 
sessions that can be controlled separately and that can 
simultaneously perform different activities. 

ACTIVITIES 

Teaching in the Study 700 environment is based on a set of 
preset learning activities, which can be utilized in the basic 
teaching of any subject. You can set different activities for 
different sessions.  

The Study 700 program includes the following activities: 

 Self-Access 

 Discussion 

 Tutoring 

 Web Browsing 
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COMPONENTS OF THE TUTOR INTERFACE 

 

MENUS 

 

The three menus (File, Tools and Help) give you access to 
settings and preferences, to your license information, and to 
online help. 

CLASSROOM VIEW 

 

You can edit the classroom view by adding and removing 
student workstations and by arranging them to match your 
physical classroom environment. Student icons are color-
coded according to the sessions they are in. 

Menus 

Classroom view 

Sessions 

Function buttons 

Activity 
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SESSIONS 

 

Study 700 has six different sessions that students can be 
placed into. The sessions allow you to divide your class into 
smaller groups that can be engaged in different learning 
activities. Empty sessions are grayed. 

FUNCTION BUTTONS 

 

The different functions can be used for either all the students 
or the students of a single session. 
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ACTIVITY VIEW 

 

The activity view is where you can select and control the 
activity of the current session. 

COMMUNICATION 

To discuss with a single student, click a student icon and 
select Discuss.  

To talk to a session, select a session and in the Function 
Buttons click the icon next to the Talk button. 

 

To talk to the entire class, click on Talk in the Function 
Buttons. 

 

FUNCTIONS 

FUNCTIONS FOR A SINGLE STUDENT 

To use the different functions for a single student, click on 
the student icon. This opens a student monitoring window 
with functions that apply to the selected student. 
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For more information on the different functions in the 
monitoring window, see Functions for a single student later in 
this guide. 

FUNCTIONS FOR ENTIRE CLASS / A SESSION 

The functions in the function buttons can be used for the 
currently selected session or for the entire class. 

  Clicking the button itself will perform the function for 
the entire class. 

 

For the entire 

class 
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  Clicking the icons will perform the function for the 
current session. 

 

For more information on the different function buttons, see 
Functions for entire class / a session later in this guide. 

For the current 

session 
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GETTING STARTED 

STARTING STUDY 700 TUTOR 

After the installation, you are ready to start Study 700. To 
start Study 700 Tutor, open the Windows Start menu (lower 
left corner on your screen) and select Programs – Sanako – 
Study 700 – Tutor. 

SELECTING TUTOR NAME AND CLASS 

Before the Tutor application opens, you need to select your 
tutor name and the class that you are teaching. If you are not 
teaching a specific class, you can select the template class 
or an empty class and then manually pick the students you 
want to include in the class. 

 

For information on adding students to the classroom, see the 
Adding students into the classroom section below. 

For information on setting tutor names and classes, see the 
Sanako Study Technical Guide. 

STARTING STUDY 700 STUDENT 

To open the Study 700 Student interface, click the Windows 
Start menu and select Programs – Sanako – Study 
Student – Student. The teacher can also at any time display 
the Student applications on student workstations by clicking 
the PC Control button on the Tutor interface and selecting 
Show student application. 

Even if the Study 700 Student application is not open on the 
student screen, it is always running in the background 
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listening to commands from Study 700 Tutor when the 
student workstation is on. 

ADDING STUDENTS INTO THE CLASSROOM 

To add students into the classroom, click the Show Corridor 
text at the bottom of the Tutor interface.  

 

This opens a window that displays all the currently running 
student workstations. Select the workstations that you want 
to add and then click the Add to session A button. 

 

MOVING AND ARRANGING THE STUDENT ICONS 

To move and arrange the student icons on the classroom 
view, open the Tools menu, select Admin and then Move 
and align student icons. This opens a control bar with 
functions for arranging the classroom layout.  

EDITING STUDENT NAMES AND NUMBERS 

To edit the student names and numbers, right-click on a 
student icon and select Edit and then either Name or 
Position.  

You can also let the students enter a name for themselves. 
To do this open the Tools menu and select Ask student 
names. 
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REMOVING STUDENTS 

To move a student from the class back to the corridor, right-
click a student icon and select Send to corridor. The 
student can then be selected to another class by another 
teacher. 

To remove a student and the student icon from the class 
view, right-click a student icon and select Exclude from 
class (and layout). Once the student icon is removed, the 
classroom configuration can be saved as a new class. 

ATTENDANCE REPORT 

If you want to keep a digital record of students‟ attendance, 
you can view and save an attendance report of the current 
class. Open the File menu, select Create Attendance 
Report and then select where to save the attendance file.  

 

GETTING HELP 

If you are unsure of some of the functions in the applications, 
you can access the Study 700 online Help file and view video 
tutorials in either the Teacher or Student application by 
opening the Help menu and selecting Help or Video 
Tutorials. 

ENDING A LESSON 

To end the current lesson and close Study 700 Tutor, open 
the File menu and select Exit or click the „X‟ button in the top 
right corner of the teacher application. 

RESTARTING THE TUTOR APPLICATION 

To restart the tutor application, open the File menu, select 
Restart and then either the Restart option to start again with 
the same tutor and classroom, or the Restart and select 
Tutor option to start again with a different tutor and 
classroom. 
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GROUPING STUDENTS INTO SESSIONS 

You can place students into six different sessions (A-F). 
Empty sessions are grayed. 

 

There are three ways to select students for a session: 

 Click Add and then the student icon you want to add. 

 Click Add, and with the left mouse button pressed 
down drag the selector over the desired student icons. 

 Right-click a student icon, select Move to Session 
and the letter of the session you want to place the 
student into. 

You can remove students from a session by adding them 
into another one in one of the ways explained above. 
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STUDENT ICONS 

CLASS VIEW 

The Study 700 class view is a graphical layout of your class. 
Your students are displayed as student icons that reflect their 
current status. 

 

The student icons are also color-coded according to the 
session they are in, allowing you to see at a glance, which 
session the students belong to. 

STUDENT ICONS 

 Student name and position 

Student names and student position numbers are indicated 
below each student icon.To edit the name or position of a 
student, right-click the icon, select Edit and either Name or 
Position. 

 Student calling teacher 

A question mark on top of the student icon indicates that the 
student wants to speak with the teacher. To talk with the 
student, click the student icon and select Discuss. 
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 Message from student 

Messages from students are displayed above the student 
icons 

 Locked student  

A locked student workstation (Lock PC, Lock Screen, or Lock 
Mouse and Keyboard). 

 Student receiving tutor screen 

A student who receives the Tutor screen, when the Tutor 
screen is shared to students. 

 Student receiving model student’s screen 

A student who receives the Model Student screen, when a 
student screen is shared to others. 

 Model student 

A student whose screen is being shared to other students 
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FUNCTIONS FOR A SINGLE STUDENT 

Clicking a student icon opens a student monitoring window 
with functions that apply to the selected student. 

 

DISCUSS 

Talk with the student. Adjust the student volume with the 
slider during the discussion.  

SHARING TEACHER-STUDENT DISCUSSION  

You may also share a teacher-student discussion with 
others. To do this, first click Talk to address the whole class 
and then select a student and click Discuss.  

PC CONTROL 

PC Control options include shut down functions, locking 
functions, the possibility to launch programs, selecting which 
applications students have access to, disabling Internet use 
and showing or hiding student applications on the student 
computer. 

For information on the different PC Control options, see PC 
control options later in this guide. 

REMOTE CONTROL 

View and control the selected student‟s screen in the Screen 
Control window. 

For more information on the functions in the Screen Control 
window, see Screen Control window later in this guide. 
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HOMEWORK 

Distribute exercise files and material to students. Students 
can then work with the files and hand in their work once they 
are finished.  

For more information on the Homework function, see 
Homework later in this guide. 

MESSAGES 

Opens the message window in which you can send a 
message to the student. 

 

TO SEND A MESSAGE 

1. Type your message in the Message text field. 

2. The current student is selected as the recipient by 
default. 

3. Click Send. The message is now displayed on the 
student screen. 
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FUNCTIONS FOR ENTIRE CLASS / A SESSION 

The functions in the function buttons apply either to all 
students or to the currently selected session. 

 Clicking the buttons will perform the function for the 
entire class. 

 

 Clicking the icons will perform the function for the 
current session. 

 

TALK 

Talk allows you to talk to students while the student 
microphones are muted. To end the call, simply click the 
Talk button again. 

Control the 
entire class 

Control the 

current session 
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The Talking to students text above the Function buttons 
indicates when the students can hear you. 

 

SHARING TEACHER-STUDENT DISCUSSION  

You may also use the talk function to share a teacher-
student discussion with others. To do this, first click Talk to 
address the whole class and then select a student and click 
Discuss.  

PC CONTROL 

The different PC control options give you full control over the 
shutdown functions of student computers and also allow you 
to launch programs, select which applications students have 
access to, disable Internet use and show or hide student 
applications on student workstations. With the locking 
functions you can ensure that the students‟ full attention 
remains on the task at hand. 

 

For more information on the different PC control options, see 
PC control options later in this guide. 

SCREEN CONTROL 

The different screen control options allow you to monitor and 
control student screens, as well as to share either the 
teacher screen or a selected student‟s screen to others. 
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AUTOSCAN 

Opens the Screen Control window and allows you to monitor 
the screen activity of student workstations automatically, one 
after the other. 

For more information on the functions in the Screen Control 
window, see Screen Control window later in this guide. 

THUMBNAILS 

Selecting Thumbnails displays thumbnail images of student 
screens in place of the student icons. 

 

You can adjust the size of the thumbnail images in Tools 
menu > Preferences > Tutor tab. 
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THUMBNAILS IN SEPARATE WINDOW 

Selecting Thumbnails in separate window opens an 
additional window where the student thumbnails are 
displayed.  

TUTOR SCREEN TO STUDENTS 

This allows the teacher to display the teacher screen on the 
student screens while talking to them. During the screen 
sharing, students will see the teacher screen but are not able 
to use their keyboard or mouse to control it. 

ON THE AIR 

When the Tutor screen is shared to students an On The Air 
indication panel appears in the lower-right corner of the tutor 
screen 

 

To end the screen transfer, click on the Stop Transfer 
button in the On The Air panel. 

 

MARKER TOOL 

The marker tool allows instructors to make annotations onto 
the shared tutor screen. To use the Marker Tool, click on the 
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Marker Tool button in the On The Air panel. 

 

This will open a toolbar with different annotation tools into the 
top right corner of the Tutor screen. 

 

 

 

 

 

 

 

 

MODEL SCREEN TO STUDENTS 

This displays a selected student‟s screen to the other 
students and the model student can also talk to the others. 
Instead of teaching all the sessions yourself, you can use 
screen sharing to set one of the students to instruct the 
others or to let a student give a presentation. 

To set a model student, select Model screen to students 
and then click on the desired student. 

Select annotations by dragging 

the selector over them 

Drawing tools: line, 
arrow, square, circle 

and free-hand. 

Type in text or 
place a pointer 

Selections for color 

and width of line 

Clear the drawings 
and minimize or close 
the marker tool bar. 
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HOMEWORK 

Distribute exercise files and material to students. Students 
can then work with the files and hand in their work once they 
are finished.  

For more information on the Homework function, see 
Homework later in this guide. 

ONENOTE 

Microsoft OneNote is a tool for note taking, information 
gathering, and multi-user collaboration. The application 
allows teachers to distribute their classroom notes to 
students in the Study live learning session. 

Clicking the OneNote button launches Microsoft OneNote for 
both the teacher and students. Teachers can then click the 
Send button to send their notes and content to the students.  

Send notes to students

OneNote

The entire page content will be always updated in the 
students‟ OneNote when the tutor clicks Send. A new page 
will be created for the students if one does not already exist. 

Note: Sanako Study only supports Microsoft OneNote 2007. 
The OneNote feature requires that Microsoft OneNote is 
installed on the tutor and student computers. Microsoft 
OneNote is a standard part of Office 2007. 

WEB BROWSER 

Launch – Open Web browsers for the student and the tutor. 
You can use the tutor Web browser to control the student‟s 
browsing. 

Hide – Close both the student and tutor Web browsers. 

For more information on how to use the Web Browser and on 
how to control and set limits to students‟ navigation, see Web 
browser later in this guide. 

WHITEBOARD 

The Whiteboard is a tool that allows users to make 
annotations onto selected images. You can use any pictures 
as the background of the Whiteboard. 
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The Study 700 Whiteboard opens in a separate window. 

 

File menu  

 

New – Clear the Whiteboard and start a new project. 

Open… – Open a saved Whiteboard project. Whiteboard 
projects include the background image and the annotations. 

Save – Save the current Whiteboard project under the same 
name.  

Save As – Save the current Whiteboard project as a 
Whiteboard project file, in which case the drawings can later 
be edited, or as a picture which cannot be edited. 

Exit – Close the Whiteboard window 
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EDIT MENU 

 

Undo – Undo the previous command. 

Cut – Cut the selected annotations and pictures. You can 
select annotations and pictures with the Selector tool.  

Copy –Copy the selected annotations and pictures. 

Paste –Paste any annotations or pictures that you have 
copied onto the Whiteboard. 

Delete – Delete the selected annotations or pictures. 

Bring to Front – Bring the selected picture on top of the 
others on the Whiteboard.  

Send to Back – Send the selected picture behind the others 
on the Whiteboard. 

Select All – Select all the annotations and pictures on the 
Whiteboard. 

INSERT MENU 

 

Insert a picture onto the Whiteboard. You can insert and 
arrange multiple pictures onto the Whiteboard. 

OPTIONS MENU 

 

Background -- Select a new image to be used as the 
Whiteboard background or clear the background. If the 
„Automatically Clipboard‟ option is selected, any image that 
you capture or copy is automatically pasted as the 
Whiteboard background 
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Color – Select the color of the Whiteboard drawings. 

Width – Select the width of line for the Whiteboard drawings. 

Text – Select a text font style and size for the text tool. 

WHITEBOARD TOOLS 

 

 

 

 

 

 

 

MESSAGES 

The message function allows you to display messages on 
student workstations, for example, to offer them additional 
guidance and instruction. 

TO SEND A MESSAGE 

1. Type your message into the Message text field. 

 

2. Select the message recipient. 

 

Select annotations and 
pictures by dragging the 

selector over them 

Drawing tools: line, 
arrow, square, circle 

and free-hand. 

Type in text or 
place a pointer 

Select the color and 

width of line 
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3. Click Send. The message is now displayed on student 
screens. 

CHAT 

The text chat feature can be used by both teachers and 
students for quick and easy communication, without 
disturbing the other students. 

Clicking Chat opens the Chat window. Study 700 has 
separate chat rooms for each session and you can either 
view the chat history of a single room or monitor all the chat 
rooms simultaneously in a mosaic window. 

 

Click on the letters to select which session‟s chat history is 
displayed in the Chat window. 

 

If All is selected then all six sessions are displayed 
simultaneously, allowing you to monitor all the chat 
discussions at the same time. 

ENABLE / DISABLE CHAT FUNCTION 

 

The Chat function is unavailable for students, until you 
enable it for them. Clicking this button will enable or disable 
the chat function for the session that is currently displayed, 
or if you are in the All view, for all sessions. 
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TO SEND A CHAT MESSAGE 

1. Type your message into the field at the bottom of the 
window. 

 

2. Click Send. 

3. The message will be displayed for the currently selected 
session, or if you are in the All view, for all sessions. 

SAVE / PRINT / CLEAR CHAT HISTORY 

Click on the icons at the upper right corner to  

 save,  

 print, or 

 clear  

the currently displayed chat history, or if you are in the All 
view all the chat histories. 
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FEEDBACK AND VOTING 

Feedback and voting features allow teachers to run on-the-
spot queries to determine the level of student understanding 
and to establish whether students are following the lesson or 
having difficulty. 

These features are available through the Live feedback and 
Voting buttons. 

 

Live feedback allows students to indicate to the teacher the 
degree to which they are following instruction and if they 
need further explanation of the topic at hand.  

With Voting teachers can quickly ascertain and test student 
understanding by sending them multiple-choice questions.  

LIVE FEEDBACK 

The Live feedback feature allows students to express how 
well they have been able to follow the lesson. Before 
students are able to give live feedback during a lesson, the 
teacher has to enable it by clicking the Live feedback button 
on the teacher interface. 

Once the teacher enables Live feedback, three icons will 
appear on the student application.  
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Students may click these icons to express whether they are 

following  the lesson without any problems, are 

confused  and may need something to be explained 

in more detail, or are lost  and have not understood 
the topic at hand.  

The teacher sees a graphical representation of the 
percentage of responses and an exclamation mark next to 
each student that has provided feedback. Please note that 
the system assumes that no feedback equals “following” and 
hence green. 

 

Clicking the exclamation mark next to a student icon will 
clear the student feedback status. 

VOTING 

Clicking the Voting button opens a window where you can 
create a multiple choice question and then send it to your 
students.  
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CREATING MULTIPLE CHOICE QUESTIONS 

 

1. Enter your question 

2. Select how many answer alternatives there will be. 
You can have either two (A…B), three (A…C), or an 
unlimited (A…n) number of alternatives. 

3. Enter the answer alternatives into the fields under 
Choices and then check the correct answer 

4. To start the test for students, click on the Send button.  

If you want to start over (without sending the question) or 
create further questions, click on the Create new button at 
the lower left corner of the Voting window. 

 

ANSWERING MULTIPLE CHOICE QUESTIONS 

When the teacher has sent the question to students it is 
displayed on the student screens and the students can select 
the correct response alternative.  
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They confirm their answer by clicking the Send button.  

While the students answer, a figure displaying the 
percentages of student responses is displayed and updated 
on the teacher screen in real time 

 

When the students have had enough time to answer the 
teacher may choose to reveal the correct answer for the 
students by clicking the Send correct answer button. The 
correct answer will then be highlighted in green at the 
student end. 

 

PLAYLIST 

The Playlist feature allows you to assign media files for 
students and to access a library of your own teaching 
materials. To open a window where you can manage files, 
click Playlist in any session tab. 

 

Manage student playlists and 
your teaching materials 
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The Playlist window displays the Session playlist(s) (top 
half of the window) and the Tutor file area (bottom half of 
the window). 

 

Study 700 has separate playlists for each session and for the 
tutor. You can use the session playlists to provide the 
students with material that they can access themselves. 

The files that have been added to a session playlist by the 
tutor are available for students in their student player playlist. 

 

SELECTING ACTIVE SESSION PLAYLIST 

Click on the letters to select which session playlist is 
displayed. 

 

If All is selected then all six session playlists are displayed 
simultaneously. This allows you to add and copy files to all 
playlists, and also to launch files to all the sessions at once. 

Tutor files 

Session 
playlists 
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BROWSING THE TUTOR FILE AREA 

The Tutor file area is for storing files that you may use during 
your lesson. You can browse the folders and create new 
subfolders with the function buttons at the top right of the 
Tutor file area. 

 Move up in the folder structure 

 Create a new folder 

COPYING FILES 

To copy files from the tutor file area to the active session 
playlist(s) or vice versa, click on a file in the Playlist window 
to select it and then click on the Copy button.  

 

Depending on where the selected file is located in, the arrow 
in the Copy button changes automatically to indicate 
whether the file will be copied from the tutor file area to the 
session playlist(s) or vice versa. 

FILE FUNCTIONS 

File functions are located at the top of the Playlist window  

 

 Settings allow you to change the location for storing 
playlist files and refresh the file lists 

 Open the selected file on the tutor screen 

 Launch the selected files for students  
         Note: File has to be located in a shared network location 

 Copy and launch files for students 

 Launch files from a location outside the playlist file 
areas 
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 Close the selected files on the student workstations 

 Close all launched files  

 Add files to the active file area 

 Remove the selected file 

 Add homework files to the students‟ homework list 
and access the Homework window where you can distribute 
and collect exercise files. 
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HOMEWORK 

The Homework feature allows teachers to distribute material 
to students for independent work. Students are then free to 
save these files on a USB stick, for example, and work on 
the material at school or at home.  

To open the Homework window where files can be 
distributed to and collected from students, click the 
Homework function button.  

 

This opens the Homework window where you can assign 
homework material to students and collect the students‟ work 
back. 
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ADDING AND REMOVING HOMEWORK FILES 

When handing out homework material to students, you need 
to first select who you want to give the homework files to with 
the Target drop-down menu.   

 

The icons above the handout files list allow you to add and 
remove homework files.  

 

 Add a handout file. A window opens automatically 
where you can browse for the file.  

 Remove the selected file form the handout files list 

 Remove all files from the handout files list 

 Preview the selected handout file on the teacher 
computer 

The files that have been added to the homework files by the 
tutor are available in the Student Player Homework file area. 
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COLLECTING HOMEWORK 

The lower part of the Homework window includes the 
functions for collecting homework assignments back from 
students.  

 

SELECTING COLLECTION FOLDER 

Before students can hand in their work, you need to define 
the location where the collected files will be saved. Click 
Browse and select a suitable folder. The folder path is then 
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displayed in the homework window. 

 

HANDING IN HOMEWORK FILES 

To allow students to hand in their work, click the Allow 
returning button. This opens a window on student 
computers where students can send their homework files 
back to the teacher.  

 

At the student end, click Browse and select the file you wat 
to hand in. The file is now displayed in the student window 
for returning homework. To send the file to the teacher, click 
Send. The Status column tells the student when the file has 
been delivered. 

 

VIEWING RETURNED FILES 

The teacher can view the returned files, by clicking the Open 
folder now link. If the Open folder when enabled option is 
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checked, then the folder where the files are collected to is 
opened automatically when the teacher allows students to 
hand in their work.  
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PC CONTROL OPTIONS 

PC Control options include shut down and start up functions, 
locking functions, and the possibility to launch programs, 
select which applications students can use, disable Internet 
use and show or hide student applications on the student 
computers. 

 

SHUT DOWN OPERATIONS 

Selecting Shutdown operations opens a dialog that allows 
you to control the shutdown functions of student computers. 

 

Checking the Allow students to save their open files 
option will let the students save open files before the 
selected shutdown command is performed. 

Shut down – Shut down student computers 

Log off – Log off current users on student computers 

Restart – Reboot student computers 

SWITCH ON STUDENT PC 

Selecting Switch on Student PC starts up the student 
computers in the group or classroom.  
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Note: This function requires that Wake-On-LAN has been 
enabled on the student PC network cards.  

LOCKING OPTIONS 

Lock PC – Students‟ screens are blacked out and students 
are unable to use neither their keyboard nor mouse. You can 
then launch files or applications on top of the blank screen. 
To unlock the student computers, re-click the option. 

Lock screen – Students‟ screens are blacked out, but 
students can still use their mouse and keyboard to work with 
anything you launch on their screen. To unlock the student 
computers, re-click the option. 

Lock keyboard and mouse – Students are able to view 
their own screens, but will not be able to use their keyboard 
or mouse. To unlock the student computers, re-click the 
option. 

Lock Voice Insert ON – Lock the Voice Insert mode On or 
Off for students. This allows you to make sure that your 
students have the correct recording mode for the lesson. 

LAUNCH PROGRAM 

Selecting Launch program allows you to launch any 
programs on the student computers or in a shared area for 
the students, as well as create shortcuts to programs that are 
frequently used.  

TO LAUNCH A PROGRAM FOR STUDENTS 

 

1. Either type in the name of the program or click 
Browse to browse for it (*.exe files). 

2. Select whether the program window on student 
screens should be Normal size, Maximized, or 
Minimized to the taskbar. 

3. Click Launch. 
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TO CREATE A SHORTCUT 

 

1. Click Browse to browse for a program  

2. Click Save program shortcut to shortcuts list to 
create a shortcut to the selected program. 

3. You can now launch the program to students simply 
by double-clicking the shortcut. To remove a shortcut, 
simply select it and press Delete on your keyboard. 

TO CLOSE A LAUNCHED PROGRAM 

 

1. Select a launched program that you want to close on 
the list. 

2. Select whether you want to allow students to save 
their work before the program is closed. 

3. Click on the Close button to close the selected 
program or click on the Close all button to close all 
launched programs 

SHOW STUDENT APPLICATION 

Clicking this button will either show or hide the student 
applications on the student screens. 
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BLOCK APPLICATIONS 

Blocking applications allows you to select which applications 
students are allowed to access and use.  

  

To allow or prevent applications 

1. Select who you want to prevent or allow applications 
for with the Target drop-down menu. You can use the 
function for all students, a group, or a single student 

 

2. Check the applications that you want to prevent under 
the Prevented applications list or the applications 
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you want to allow under the Allowed applications list 

 

3. Click either Prevent or Allow to activate the 
selections 

 Click Prevent to deny the selected applications. 
Students will now be able to use any applications 
except the ones that have been checked.  

 Click Allow to allow students to use only the 
selected applications. Students will now be unable 
to access any applications except the ones that 
have been checked. 
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EDITING THE LISTS OF DENIED AND ALLOWED 
APPLICATIONS: 

 

 To add a selected application to the denied and 

allowed applications lists, click the  button and 
enter the name of the application.  

 To add all the applications currently open on the 

student computers to the lists, click the  button. 

 To load the application list from a file, click the  
button for the Denied applications or Allowed 
applications list. 

 To save the application list into a file for later use, 

click the  button for the Denied applications or 
Allowed applications list. 

DISABLE INTERNET 

Selecting Disable Internet prevents the students from 
opening and using Web browsers on the student 
workstations. 
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SCREEN CONTROL WINDOW 

The screen control window has all the functions for 
monitoring and controlling student screens. 

 

Select a screen control mode with the buttons on top of the 
screen. 

 

MONITOR 

View the selected student screen and listen to the student. 

AUTOSCAN 

Autoscan automatically changes monitoring from one student 
to the next after a set period of time. 

REMOTE CONTROL 

Control the currently displayed student screen with your 
mouse and keyboard, for example, to help the student with a 
task. The student‟s mouse and keyboard are locked during 
Remote Control. 

COLLABORATE 

Control the currently displayed student screen with your 
mouse and keyboard simultaneously with the student, for 
example, to instruct the student in the use of an application. 
Both you and the student will move the same mouse pointer. 
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NEXT / PREVIOUS STUDENT SCREEN 

 

Use the arrow buttons to change to the next or previous 
student screen. 
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WEB BROWSER 

The Study 700 Web browser contains all the functions of a 
standard browser, as well as additional features that allow 
you to control students‟ navigation. 

 
The tutor’s Web browser 

BROWSER CONTROL BUTTONS 

 

Back moves back to the last visited Web page. 

 

Forward moves to the page you viewed before 
clicking the Back button. 

 

Stop stops opening and loading a Web page. 

 

Refresh gets the latest version of a currently 
viewed Web page. If a page cannot be 
displayed, you may try to reload it by clicking 
Refresh. 

 

Home moves to the default home page. 

 

Search launches an Internet search page. 

 

Print prints the current web page. 

 

Send opens student browsers on the Web 
page you currently have open. For more 
information see the To open Web browsers for 
students part later in this section. 

 

Follow makes student browsers follow your 
navigation. For more information see Follow 
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mode later in this section. 

 

Settings allows you to block pop-up windows 
and to show or hide the toolbar on student 
browsers 

TO OPEN WEB BROWSERS FOR STUDENTS 

1. You can open the Web browser for all students 
(Function buttons; button) or for a session (Function 
buttons; icon) 

 

2. Select one of the above. The tutor‟s Web browser 
opens on your screen. 

 
 The tutor’s Web browser 

3. Go to the Web page you want student browsers to 
open. 
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4. Click Send. Web browsers will now open on student 
screens. 

 
 Student Web browser 

FOLLOW MODE 

 

In the Follow mode, students‟ browsers will display the Web 
site that is open on the teacher‟s browser. The students are 
only able to follow your navigation as the control buttons are 
hidden from their browsers. 

 
Student browser in Follow mode 

This allows you to browse the web and present material 
while student browsers follow your navigation. Once the 
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presentation is over, you can let students continue with 
independent study. 

To Enable / Disable the Follow mode, click on the Follow 
button. 

SETTINGS 

Settings allows you to block pop-up windows and show or 
hide the toolbar on student browsers. 

 

Blocking pop-up windows prevents any additional and 
unnecessary windows from opening automatically when a 
student opens a Web page. 

Hiding the toolbar on student browsers is useful when you 
want students to concentrate on the current Web page 
instead of browsing elsewhere. 
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ACTIVITIES 

GENERAL PROCEDURE 

Study 700 has a number of pre-set learning activities that 
form the basis for teaching with Study 700. The Activity view 
only displays the options that are relevant to the currently 
selected activity. 

 

ACTIVITY SELECTION 

First of all, select an activity that you want to start for the 
current session. 

 

MEDIA SOURCE SELECTION 

The Media source is what the session hears during an 
activity. In Tutoring, the Media source‟s screen is also 
transferred to the students.  

 

To start an activity for a session 
 

1. Select a session 
 

2. Add students to a session 
 

3. Select an activity 
 

4. Select a Media source 
 

5. Activity specific settings 
 

6. Start / End activity 

2 
3 
4 
 
 
 
5 
 
 
 
 

 
6 

1 
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None – The activity will be run without a media source. 

Tutor – You can talk to the students during the activity. 

Student – A selected student can talk to the others during 
the activity.  
If you select Student as the media source, you need to then 
click on a student icon to select the source student.  

Note: The Self-access activity does not have Media source 
selection. 

ACTIVITY CONTROLS 

 

Start – Starts the selected activity and plays the Media 
source to students 

Pause – Pauses the current activity and the media source. 
The Start button turns into Pause when an activity is 
running. You can pause the activity, for example, to let the 
students do an exercise or to give them instructions. 

End – Ends the activity. The media source is stopped and 
student players are set to free. 
If the media source was a file, the file will remain in the 
student players and they can listen to it again. 

Lock / Free – Locks and frees student players. When the 
student players are locked students are unable to use any of 
the player controls and are only able to listen to the media 
source. Once the student players are freed, students will 
have full control over their players, allowing them to work 
independently 

Replay – Plays back both the media source and the student 
track to the students again, allowing them to listen to their 
own work. Replay is only available when the program source 
is a media file. 

Clear session – Clears all the settings and switches back to 
Self-Access. 

SELF-ACCESS 

In the Self-access activity, students have free access to use 
their workstations and the Study 700 Student application. If 
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no other activity is selected, the students are always in Self-
Access. You can still use all the Study 700 functions to 
communicate with and control the students if needed. 

DISCUSSION 

In the Discussion activity students practice conversational 
skills in pairs and small groups and learn to express ideas 
and opinions. 

 

To set all the students in the same group, select All 
students in session.  

To set up smaller groups, select Fixed group size and then 

use the slider  to select a group size (from 
two to all students). 

There are three ways to form the discussion groups.  

Fixed  – Study 700 creates the groups in order 
according to the student numbers 

Random  – Study 700 creates the groups randomly 

Select  – You can create the groups manually, by 
clicking on the students that you want to form a group 
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Under Options, you can also select if you want to record 
the student discussions or allow students to record 
themselves when their recorders are not locked.  

Group members are shown in the classroom view and as a 
list on the student screens 

         

As soon as the groups have been formed, students have an 
audio connection with the other group members and can 
begin the discussion. 

During the Discussion activity student players are locked 
except for volume adjustment, teacher call and bookmarks. 

COLLECTING STUDENT RECORDINGS 

At the end of the Discussion activity you have the option of 
collecting the student recordings as audio files for later 
review. When you end the activity, a file collection window 
will automatically pop-up. 
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Click Collect to save the student recordings into the 
displayed folder. If you want to collect to a different folder, 
click the Browse… button.  

ADVANCED FILE COLLECTION OPTIONS 

Click the Advanced button in the Collect student files 
window to access additional settings for file collection. 

 

 

TUTORING 

In the Tutoring activity, the screen of the media source is 
transferred to the session and the source can also talk to the 
others. You can either select yourself or one of the students 
as the media source. 

If you select Tutor as the media source, the Study 700 Tutor 
application is minimized to the taskbar, allowing you to 
instruct students using any applications that are on the 
teacher computer. 

When the Tutor screen is shared to students an On The Air 
indication panel appears in the lower-right corner of the tutor 
screen. 

 
Please note that during Tutoring the Stop Transfer button 

Select whether the files will be named 
with the student names or student 
numbers. Add time stamp adds the 
collection time into the file name. 
Check this if you collect student files 
more than once during a class to avoid 
overwriting existing files. 

After you have made your selections, 
click on the Collect button to collect 
the student files 

The files will be collected into the 
displayed folder. To change the folder, 

click on the Change button. 

Select the tracks you want to collect 
and a file format for the collected files 



60    Sanako Study 700 v. 7.00 User Guide  

will not end the screen transfer. Instead you need to End the 
activity itself to stop sending out the teacher screen.  

If you select Student as the media source, you can also 
select whether you want to view the student screen during 
the activity.  

WEB BROWSING 

Starting the Web browsing activity launches Internet Explorer 
browsers on student workstations. You can set limits to their 
access to Web pages. 

 

WEB POLICIES: PREVENT AND ALLOW 

Prevent – students are able to access all Web sites, except 
the ones on the list. 

Allow – students are only able to access the Web sites on 
the list. 
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To add an address to the list, type or copy it to the field at 
the bottom and click Add. 

To remove an address from the list, select the address and 
click Remove. 

LOAD / SAVE / PRINT / CLEAR ADDRESSES  

Click on the icons to: 

 Load a previously saved file of denied / allowed 
addresses 

 Save the current list of addresses for later use 

 Print the current list of addresses 

 Clear the list of addresses 

OPEN MY BROWSER  

This opens the tutor Web browser, with which you can take 
control of the student browsers. 
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STUDY 700 STUDENT 
APPLICATION 

COMPONENTS OF THE STUDY 700 STUDENT 
APPLICATION 

 
Sanako Study 700 Student interface 

The Expand and Chat buttons open new windows on the 
interface. 

Menus 

Status display 

Student media player 

Call teacher / Send message 

Adjust volume / Mute sidetone 

Chat window 
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Sanako Study 700 Student interface with the Media Player and Chat windows 

Below, you will find short presentations of the components of 
the Study 700 student interface, each of which will be 
explained in more detail later in this guide. 

MENUS 

 

The three menus of Study 700 Student give you access to 
file functions, settings and preferences, and to online help. 

File functions 

Media player 

Chat window 
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MEDIA PLAYER 

Clicking Expand / Minimize opens and closes a window that 
contains all file functions and the student media player. 

 

For more information on file functions and using the player, 
see the Media player section later in this guide. 

CHAT 

The Chat function can be enabled or disabled by the teacher. 
When enabled, clicking Chat opens a window displaying the 
chat room of the student‟s session and the other chat 
participants. 

 

For more information on the Chat function, see the  
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Chat section later in this guide. 

VOLUME ADJUSTMENT 

 

To adjust your speaker volume, move the slider. 

To switch sidetone on/off, click on the microphone icon. 
When sidetone is on the students can hear their own voices 
through their headsets while speaking. 

STATUS DISPLAY 

 

The field at the lower left corner of the Student application 
displays your current status: 

 the current activity set by the Tutor  

 your current session and position number 

 you have been set as a model student. This means 
that your screen is shared to the other students and you can 
talk to them. 

 the lock symbol indicates whether your player controls 
are locked or free 

GETTING HELP 

The Help menu in the Student application allows you to 
access an online help file for Study 700, to view video 
tutorials and to view version information on your Study 700 
Student application 
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MEDIA PLAYER 

Clicking the Expand / Minimize button opens and closes the 
media player that you can use to play back media files in 
commonly found formats, such as WAV, AVI, MP3, as well 
as in Sanako‟s own file formats MFF and MAA. This allows 
you to also use material created with the Sanako Authoring 
tool, Lab 300, and Media Assistant. 

 

 

 

 

FILE FUNCTIONS 

 New  – Clear the Player. This will close the currently 
open file and remove all bookmarks. 

 Open  – Open a media file for the Player. This opens a 
dialog in which you can browse for a file. 

 Save – Save the currently open file with the student 
track. By default the Study 700 Player saves files in .mff 
format. The .mff files include the original program track, the 
student recordings and the set bookmarks. 

 Mode – Play audio CDs, or view audio graphs of the 
program and student track. For more information about the 
player modes, see the section Player Mode below. 

 
My files – Display the files in your own personal file area. All 
students have personal file areas where they can store files 
for themselves. 
Playlist – Display the files in your session‟s playlist. Each 
session has its own playlist assigned by the teacher. 

Display your personal 
files, session playlist, or 
assigned homework files 

Clear the Player, 
Open new file 
and Save file 

Your personal files, 
session playlist, or 
assigned homework files 

Bookmarks 

Player controls 

The open file, its 
total length, and 
the time played 
from the file 



 Study 700 Student application    67 

Homework – Display the files that the teacher has assigned 
for your individual work. You can save these files and work 
on them at school or at home. 

 

Note: Some file functions are also available in the File menu 
of the Study Student application. 

 

 

TRACK DISPLAY 

 

 

 

 

To adjust the balance between the program and student 
tracks, move the vertical slider next to the track display 

To isolate a segment of the media file to be played 
separately move the small tabulators at each end of the track 
display by holding your mouse button down over them. 

Note: The tabulators are not available when audio graphs 
are used. 

BOOKMARKS 

 

Bookmarks allow you to mark places to return to in the 
program. Clicking a set bookmark will start playing from the 
selected place. 

To set a bookmark, click Set. This will add a mark in the 
numerical order. 

 

Adjust the balance 
between the program 
and student tracks 

Isolate a segment to 
be played separately. 
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To clear unwanted bookmarks, click Remove and then the 
appropriate bookmark. 

To name a bookmark, right-click the bookmark to open a 
dialog in which you can enter a name for the bookmark. 

  
The bookmark name is then displayed as a tooltip when you 
move the mouse pointer over the bookmark 

PLAYER CONTROLS 

 Speak – Records the student‟s voice onto the student 
track 

 Play – Plays the open file. 

 Pause – Pauses the file. When a file is being played, 
the Play button turns into Pause. 

 Stop – Stops the file. 

 Recap – Jumps back to the previous empty space in 
the program material. 

 Repeat – Repeats the selected segment or entire file. 

 Voice Insert – Activates the Voice Insert mode  

VOICE INSERT MODE 

The Voice Insert mode allows students to perform model 
imitation and question-answer exercises live without an 
audio file with ready-made gaps. In the Voice Insert mode, 
students are able to record their voices while the program 
source is paused.  

To activate the Voice Insert mode, click the Voice Insert 

button  on the Student Player. You can also activate 
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Voice Insert mode in the Study Student Player Tools menu. 

 

When a file is played back in Voice Insert mode simply click 

on the Speak  button to record your response while the 

program track is automatically paused. Clicking on Play  
again will stop the recording and continue with the program 
track.  

If you want to think before recording, click on Pause  to 
pause the program track and then click on Speak when you 
are ready to answer.  
Repeat these steps, toggling between Play, Pause and 
Speak until you are finished with the exercise. 
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PLAYER MODE 

The Mode button in Study Player gives you access to 
advanced playback features.  

 

OPEN AUDIO CD 

This mode allows you to play audio tracks on a CD using the 
teacher computer‟s internal CD drive.  

To play material on an audio CD, enter an audio CD into 
the teacher computer, click the Mode icon in Study Player 
and then select Open Audio CD. This opens a folder where 
you can select the track to be played.  

VIEW AUDIOGRAPH 

In addition to the standard view, the student player can also 
be used in an audio graph view in which the player displays 
visual representations of both the program and student 
tracks. 

 
The audio graphs allow students to view and compare the 
intonation pattern of their recorded output with the program 
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source. This is especially useful during pronunciation 
exercises. 

To activate the audio graph view click the Mode icon in 
Study Player and select AudioGraph.  

Alternatively, the AudioGraph option is also available in 
Study Player Settings in the Tools menu.  

 

HOMEWORK 

The Homework feature allows teachers to distribute material 
to students for independent work. Students are then free to 
save these files on a USB stick, for example, and work on 
the material at shool or at home.  

ACCESSING HOMEWORK FILES 

The files that have been added to the homework area by the 
tutor are available for students in the Student Player 
Homework file area. 

 

To save the homework files on the student computer, or on 
an USB stick, either double-click the file or right-click the file 
and select Save as.  

 

Once the students have saved the homework files, they are 
free to work with them anywhere.  

HANDING IN HOMEWORK FILES 

Students are only able to hand in their homework, when the 
teacher allows them to do so. When the teacher allows 
students to hand in their homework, a window opens on 
student computers where they can send their homework files 
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back to the teacher.  

 

To select the file you want to hand in, click Browse and 
locate the homework file. The file is now displayed in the 
homework window. To send the file to the teacher, click 
Send. The Status column tells you when the file has been 
delivered. 
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CHAT 

The teacher can enable and disable the Chat function for the 
students. When enabled, clicking Chat will open the Chat 
window. 

 

All sessions have their own chat rooms in Study 700. The 
Chat window displays the chat history and participants of the 
session you are currently in. 

TO SEND A CHAT MESSAGE: 

1. Type in your chat message in the Chat input field 

 

2. Click Send. Your chat message is displayed in the Chat 
output window. 
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CALL TEACHER / SEND MESSAGE 

Whenever students need to communicate with the teacher, 
they can either call the teacher or send a written message. 

 

 

 

TO CALL THE TEACHER 

1. Click the Call button. 

2. The teacher screen will now display a question mark 
on top of your student icon, indicating that you want to 
talk with the teacher. 

TO SEND A MESSAGE TO THE TEACHER 

1. Click the Message icon . This opens a Message 
window. 

 

2. Type in your message. 

3. Click Send, the message will be displayed on the 
teacher screen. 

Call teacher Send message 
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WEB BROWSER 

The teacher can launch Web Browsers for the students at 
any time and has the possibility of controlling students‟ 
navigation. 

 

TEACHER CONTROL 

If the teacher sets the student browsers into Follow mode, 
student browsers will only display the page that is open on 
the teacher‟s browser. Students are also unable to navigate 
as their control buttons are grayed. 

The teacher can also set limits to students‟ navigation by 
defining allowed and denied Web pages. 
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LOCKING 

The teacher can use different locking options in order to 
draw the students‟ attention to the current task. 

 
Locked student screen with an open application 

If the teacher has locked your PC, your screen is blacked 
out and you can only view files and applications that the 
teacher opens. 

If the teacher has locked your screen, it is blacked out but 
you can still use your mouse and keyboard to work with the 
files and applications that the teacher opens. 

If the teacher has locked your mouse and keyboard, you 
can see your own screen, but cannot use your mouse and 
keyboard. 
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EXTENSION MODULES FOR 
SANAKO STUDY 700 

Sanako Study extension modules enhance teaching and 
learning effectiveness and provide instructors with a powerful 
array of new teaching tools. 

Note: The extension modules presented below are available 
with the purchase of a separate license for each module. 

SANAKO STUDY EXAMINATION MODULE 

The Examination Module is a valuable tool that simplifies the 
creation and administering of tests. The Examination Module 
includes a 6-step “wizard” application that assists and guides 
teachers in the creation of tests. The flexibility of the 
Examination Module allows teachers to easily vary the types 
of test questions and to edit any existing tests. 

The Examination Wizard allows instructors to design any 
type of question to test a particular skill or student ability. 
Teachers may even set the time and outline instructions for 
tests before administering them, as well as preview entire 
exams.  

The Examination Module provides important follow-up by 
generating test results for both student and teacher, allowing 
students to receive immediate feedback on their 
performance or the teacher may choose not to show the 
students their results immediately. 

Students answer tests easily and conveniently using the 
Sanako Exam Player and teachers use the regular activity 
selection procedure in the Study 700 to launch exam files for 
students. Students may also use the Exam player in stand-
alone mode for additional exam practice or review. 
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SANAKO STUDY VIDEO LIVE MODULE 

The Sanako Study Video Live Module enables teachers to 
stream video from a variety of analog sources, including 
DVD and VHS players, or from media files directly to 
students.  

The module consists of a Sanako video streaming hardware 
server with Sanako software, and a simple browser interface 
for administration and video stream management. The 
Sanako Video Live Module is ready to be used once the 
video streamer is installed on the LAN, and one or more 
video sources are cabled to the video streamer.  

The module allows teachers to display video to students, or 
to simultaneously send the video material, digitize it and then 
save the video content as a media file for future use. The 
teacher can launch a video stream to student screens with a 
simple click of a Video Stream button in the Sanako Study 
interface, or by selecting it as a media source in language 
learning activities. 

SANAKO ADMIN TOOL 

Sanako Admin Tool is a software module that makes 
administration of Study classrooms within larger institutions 
easy and efficient. Admin Tool provides remote control 
features for IT-staff which eliminate the need to physically 
visit each classroom for administrative and maintenance 
tasks. 

The module allows system administrators and IT staff to 
remotely monitor and control all Study classrooms within an 
institution from a single location.  

AP- EXAM FOR STUDY 700  

This module adds the AP Exam activity to Sanako Study 
700, allowing teachers to administer AP® oral exams. The 
activity is specially designed to set up, test and collect 
student AP® responses. This module is only available in the 
US and for Study 700. The AP Exam for Study 700 –module 
includes the mp3 encoding license that is also available as a 
separate module. 

LISTENING COMPREHENSION FOR STUDY 700  

In the Listening Comprehension activity, Students listen to a 
selected media source and may complete exercises 
designed to measure their comprehension of the model 
audio. 
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MODEL IMITATION FOR STUDY 700  

In Model Imitation students listen to and repeat after model 
audio to practice the stress, rhythm and intonation of a 
foreign language. Student output is recorded onto the 
student track and student recordings are automatically 
collected after the activity 

READING PRACTICE FOR STUDY 700  

In Reading Practice students read a text and their voice is 
recorded onto the student track. Reading aloud is useful for 
practicing intonation, rhythm and pronunciation, even 
independently. Teacher can select a text document that will 
be displayed for students when the activity is started. 
Student recordings are automatically collected after the 
activity 

ROUND TABLE DISCUSSION FOR STUDY 700  

In Round Table Discussion teachers can set up small 
student groups with a designated chairman, who leads the 
discussion and assigns turns by passing a microphone 
around the group. Round table allows teachers to simulate a 
meeting environment to help advanced language learners 
strengthen their oral presentation skills. 

VOCABULARY TEST FOR STUDY 700  

This module adds the Vocabulary test activity to Study 700. 
Vocabulary test allows teachers to conduct popular word 
quiz type exercises quickly. In the activity students are 
presented with word lists and they need to enter translations 
for the words. Teachers are able to launch and save 
readymade tests, as well as collect results in an easy 
manner.  

TEXT-TO-SPEECH FOR STUDY 700  

This module adds the Text-to-Speech media source to Study 
700. Text-to-Speech allows users to copy and paste any text 
from any source, such as a Web page, and create an audio 
file with bookmarks and subtitles for students to work on. 
Created audio files are added to the Study Playlist. A 
selection of high-quality Text-to-Speech voices for different 
target languages is available 
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MP3 ENCODING FOR STUDY 700  

This module adds the possibility of saving files in mp3 format 
in Study 700. This module is currently only available in the 
UK.  
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